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Using This Guide

This guide contains information about installing and using Avid® 

Storage Manager. Avid Storage Manager is a general-purpose, 
administrative tool for updating, testing, and troubleshooting Avid 
storage media connected to Avid systems. Avid Storage Manager is 
available for the Windows 2000 operating system and the Mac OS X 
operating system.

Who Should Use This Guide

This guide is intended for administrators responsible for installing, 
testing, and troubleshooting Avid hard drives.
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xii

Using This Guide

About This Guide

This guide describes how to install and use Avid Storage Manager. The 
Contents lists all topics included in the book. They are presented with 
the following overall structure:

• Chapter 1, “Installing Avid Storage Manager” describes how to 
install Avid Storage Manager.

• Chapter 2, “Avid Storage Manager Overview” provides basic 
concepts that you should understand before using Avid Storage 
Manager.

• Chapter 3, “Using Avid Storage Manager” provides step-by-step 
procedures for using all of Avid Storage Manager’s features, with 
the exception of testing, which is described in Chapter 4.

• Chapter 4, “Testing Hard Drives” describes the various hard drive 
tests that you can perform with Avid Storage Manager and 
provides step-by-step information on how to use them.

• Appendix A, “Interpreting Error Messages” includes information 
on Avid Storage Manager test results and the actions you should 
take when a hard drive problem is discovered.

• A detailed Index helps you quickly locate specific topics.

Symbols and Conventions

Unless noted otherwise, the material in this document applies to the 
Windows 2000 and Macintosh operating systems. When the text 
applies to a specific operating system, it is marked as follows:

• (Windows) or (Windows only) means the information applies to 
the Windows 2000 operating system.

• (Macintosh) or (Macintosh only) means the information applies to 
the Macintosh OS X operating system.
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Symbols and Conventions

The majority of screen shots in this document were captured on a 
Windows 2000 system, but the information applies to both 
Windows 2000 and Macintosh systems. Where differences exist, both 
Windows 2000 and Macintosh screen shots are shown.

The Avid Storage Manager documentation uses the following special 
symbols and conventions:

1. Numbered lists, when the order of the items is important.

a. Alphabetical lists, when the order of secondary items is 
important.

• Bulleted lists, when the order of the items is unimportant.

- Indented dashed lists, when the order of secondary items is 
unimportant.

t One arrow indicates a single-step procedure. Multiple arrows in a 
list indicate that you perform one of the actions listed.

The k symbol refers to the Apple or Command key. Press and hold 
the Command key and another key to perform a keyboard shortcut.

In this document, Avid drive refers to the Avid system’s internal hard 
drive. Apple Computer, Inc. names the internal hard drive Macintosh 
HD. Microsoft names the internal hard drive My Computer. 
Depending on your system’s setup, the internal hard drive might have 
a different name.

Look here in the margin 
for tips.

In the margin, you will find tips that help you perform tasks more 
easily and efficiently.

n A note provides important related information, reminders, recommendations, 
and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.
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xiv

Using This Guide

If You Need Help

If you are having trouble using Avid Storage Manager, you should:

1. Retry the action, carefully following the instructions given for that 
task. It is especially important to check each step of your 
workflow.

2. Check the release notes for the latest information that might have 
become available after the hardcopy documentation was printed.

3. Check the documentation that came with your Avid application or 
your hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Center at www.avid.com/support. 
Online services are available 24 hours per day, 7 days per week. 
Search this online Knowledge Center to find answers, to view 
error messages, to access troubleshooting tips, to download 
updates, and to read/join online message-board discussions.

5. For Technical Support, please call 800-800-AVID (800-800-2843).

For Broadcast On-Air Sites and Call Letter Stations, call
800-NEWS-DNG (800-639-7364).

If You Have Documentation Comments

Avid Technology continuously seeks to improve its documentation. 
We value your comments about this guide, the Help, the Online 
Publications CD-ROM, and other Avid-supplied documentation.

Simply e-mail your documentation comments to Avid Technology at 

TechPubs@avid.com

Please include the title of the document, its part number, revision, and 
the specific section you are commenting on in all correspondence. 
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CHAPTER 1

Installing Avid Storage 
Manager

This chapter explains how to install Avid Storage Manager on 
Windows-based Avid systems that will be used to test and update 
hard drives. Avid Storage Manager is preinstalled on some 
Windows 2000 and Mac OS X Avid systems. If it is preinstalled on 
your system, go to Chapter 2. 

n A stand-alone installer for the Windows version of Avid Storage Manager is 
available from the Avid web site (www.avid.com). There is currently no 
stand-alone installer for the Mac OS X release of Avid Storage Manager.

This chapter includes the following topics:

• Determining if Avid Storage Manager is Installed on Windows 
2000

• Installing Avid Storage Manager on Windows 2000 Systems
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Installing Avid Storage Manager

Determining if Avid Storage Manager is Installed on 
Windows 2000

To determine if Avid Storage Manager is already installed:

t Click the Start button, point to Programs, point to Avid, point to 
Utilities, and then click Avid Storage Manager. 

If it is properly installed, Avid Storage Manager should start. If 
Avid Storage Manager does not appear on the Start menu, you 
need to install it.

Installing Avid Storage Manager on Windows 2000 
Systems

If you do not have Avid Storage Manager installed on your Avid 
system, you can download the application from the Avid Web site 
Knowledge Center at www.avid.com. Once you have the application, 
perform the following procedure to install it on your Avid system. 

n Avid Storage Manager runs only on systems that use the Windows® 2000 
operating system. It does not run on Avid systems that use the Windows NT® 
operating system.

To install Avid Storage Manager on a Windows 2000 system:

1. Navigate to the location where you saved the Avid Storage 
Manager download file. The file is in a compressed format.

2. Uncompress the file.

3. Double-click the Setup or Setup.exe icon. A welcome screen 
appears.

4. Click Next to proceed with the installation.

5. Select the country in which you purchased Avid Storage Manager, 
and click Next.
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Installing Avid Storage Manager on Windows 2000 Systems

6. Click Yes to accept the license agreement.

7. Click Next to install Avid Storage Manager to its default location, 
C:\Program Files\Avid\Utilities\Avid Storage Manager.

8. Click Next to perform a default Avid Storage Manager installation.

When you are notified that the installation is complete, click Finish.
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Installing Avid Storage Manager
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CHAPTER 2

Avid Storage Manager 
Overview

This chapter provides an overview of Avid Storage Manager’s features 
and user interface. It contains the following sections:

• Introduction

• Understanding IDs

• The Main Window

• Toolbars and Menus

• Using Avid Storage Manager with Other Utilities
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Avid Storage Manager Overview

Introduction

Avid Storage Manager is a utility that you can use to work with Avid 
hard drives in your storage subsystem. Using Avid Storage Manager, 
you can:

• Identify Avid hard drives.

• Exercise Avid hard drives using a variety of standardized tests or 
tests you customize yourself.

• Obtain test status information useful for troubleshooting.

• Report and share test results by generating log files and sending 
them by e-mail to recipients that you specify.

• Spin down Avid hard drives (SCSI and Fibre Channel only).

• Update Avid hard drive firmware (Windows only).

In addition to these features, the Avid Storage Manager user interface 
provides a main window with two views, Physical view and Volume 
view, that provide information about your storage subsystem.

c Avid Storage Manager can only test Avid hard drives. It cannot test 
non-Avid hard drives.

ASMUser.book  Page 2  Monday, June 10, 2002  10:31 AM



2-3

Understanding IDs

Understanding IDs

All the devices connected to an Avid system — for example, hard 
drives and CD-ROM drives — must have unique IDs. The Avid 
system uses these IDs to distinguish the devices from each other and 
to properly direct traffic between itself and the devices. There are a 
number of different types of IDs. This section provides a brief 
overview of each type. You will see these IDs used throughout the 
Avid Storage Manager user interface. Figure 2-1 shows how IDs are 
assigned to devices attached to an Avid system.

Figure 2-1 IDs in an Avid Storage Subsystem

Each ID contains three parts, the bus ID, the device ID, and the LUN 
ID, defined as follows:

• Bus ID: Indicates the storage bus in the Avid system to which the 
drives are connected. Avid Storage Manager can identify and 
work with storage buses that are on host bus adapter boards or the 
system board. Host bus adapter boards can have multiple storage 
buses.

Device ID 3

Bus ID 3

Host bus 
adapter boards

Avid 
system

Bus ID 2

Bus ID 1

Bus ID 0

Device ID 2

Device ID 1

Device ID 0

Device ID 0
LUN ID 3

LUN ID 2

LUN ID 1

LUN ID 0

LUN ID 7

LUN ID 6

LUN ID 5

LUN ID 4

Hard drives

Hard drives

Converter

ASMUser.book  Page 3  Monday, June 10, 2002  10:31 AM



2-4

Avid Storage Manager Overview

• Device ID: Indicates an individual device connected to a storage 
bus. Each device must have a unique ID. While there are many 
types of devices that can be attached to a storage bus, Avid Storage 
Manager is concerned only with the device IDs for the hard drives 
in your storage subsystem.

Device IDs are limited. A SCSI adapter board can accommodate 16 
IDs. One ID is used for the SCSI bus adapter itself (typically ID 7), 
leaving 15 IDs for any hard drives connected to it. A Fibre Channel 
adapter board can handle up to 126 IDs (using a Fibre Channel 
arbitrated loop). This limitation, along with the use of converters, 
gives rise to the LUN ID.

• LUN ID: LUN ID stands for logical unit number ID. LUN IDs are 
used when you introduce a converter or RAID controller into your 
storage subsystem. Converters convert a bus’ disk interface from 
one type to another (for example, converting a SCSI bus to an IDE 
bus). Every hard drive attached to a converter has a unique LUN 
ID to identify it, and the converter has a device ID. RAID 
controllers map the storage connected to them into one or more 
storage groups identified by LUN IDs.

The Main Window

Avid Storage Manager’s main window provides a visual display of 
your storage subsystem along with a variety of status indicators. The 
main window has two views, Physical view and Volume view, that 
allow you to look at your storage from a physical perspective or a 
logical perspective. Figure 2-2 shows Avid Storage Manager’s main 
window with Physical view active.

n Physical view and Volume view cannot be viewed concurrently.
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Figure 2-2 Main Window with Physical View Displayed

The remainder of this chapter describes the features in Physical view 
and Volume view. It also describes the toolbar buttons and their 
functions.

Physical View

Physical view is the default view when you start Avid Storage 
Manager (unless changed by resetting the user preferences). Physical 
view presents, in an expandable tree structure, a view of all the storage 

Physical view

Top toolbar

Side toolbar

Volume view Menu bar
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adapter boards in your Avid system and the hard drives attached to 
them. Physical view shows the physical characteristics of your storage 
subsystem.

c Physical view shows your internal and external hard drives. Do not 
select the internal system drive when you are working with Avid 
Storage Manager’s features. Drives that contain mounted volumes 
(visible in Volume view) can be selected but not tested.

Figure 2-3 shows the main window with Physical view active and 
points out the view’s most important features. The features themselves 
are described in the following sections.

Figure 2-3 Physical View Features

Partition statusHard drive descriptionAvailability/testing status

Drive icon

Adapter 
board 
description
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Adapter Board Description

An adapter board description (see Figure 2-4) includes:

• Bus ID (a bus on the Avid system where hard drives are 
connected)

• Manufacturer’s name

• Model

Figure 2-4 Adapter Board Description

Hard Drive Description

A hard drive description (see Figure 2-5) includes:

• Drive connection type: The drive connection type is either HDD or 
LUN. HDD indicates that the hard drive is connected directly to 
the adapter board. LUN indicates that the hard drive is connected 
to the adapter board via a converter.

• Bus ID, device ID, LUN ID for the hard drive (For more 
information on ID types, see “Understanding IDs” on page 2-3.)

• Manufacturer’s name

• Model

• Drive size, where 1 GB equals 1024 bytes x 1024 bytes x 1024 bytes. 
Drive sizes typically appear smaller than the manufacturer’s 
stated size because drive manufacturers state drive size in decimal 
billions of bytes.

ManufacturerBus ID Model
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Figure 2-5 Hard Drive Description

Converter Description

A converter description appears in the branch beneath the adapter 
board to which it is connected. Converter descriptions branch again to 
display descriptions of all the hard drives connected to the converter; 
you can recognize a converter’s hard drives because their description 
begins with LUN instead of HDD.

A converter description includes:

• Converter indicator

• Bus ID, device ID, and LUN ID for the converter

• Manufacturer’s name

• Model

Availability/Testing Status

To the left of the hard drive description is the availability/testing 
status indicator. Table 2-1 describes the availability/testing status 
indications you might see.

Manufacturer

ModelBus ID, device ID, LUN ID

Drive connection type Size
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n Hard drives with an availability/testing status of Passed, Failed, or Updated 
change their status back to Ready when the storage subsystem is rescanned.

Table 2-1 Availability/Testing Status Indications

Status Description

Ready The hard drive is ready to read and write data.

Unavailable The hard drive is not accessible. The drive might be 
turned off, spinning up, having a problem, or not 
supported (a non-Avid drive). Or, the device might 
be an enclosure, such as a CD-ROM drive, that is 
not testable.

Testing The hard drive is currently being tested.

Passed The hard drive has passed its most recent test.

Failed The hard drive has failed its most recent test.

Updating Updated firmware is currently being downloaded 
to the hard drive (Windows only).

Updated Firmware has been downloaded to the hard drive 
(Windows only).

Broken The hard drive is having a problem.
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Partition Status

To the right of the hard drive description is the partition status. 
Table 2-2 describes the partition statuses you might see.

Table 2-2 Partition Status Indications

Status Description

Striped The hard drive has partition and file system 
information on it and is part of a striped set of 
drives.

Unstriped The hard drive has partition and file system 
information on it but is not part of a striped set.

Raw The hard drive has no partition or file system 
information on it.

Unsupported The hard drive has an unsupported file system.

Mixed The hard drive has several partitions with different 
format types.

Remus The hard drive’s partition information indicates it 
was used for local Fibre Channel storage (Mac OS 9 
or earlier, drive format is not be usable with Mac 
OS X).

Remus Stripe The hard drive’s partition information indicates it 
was used for striped local Fibre Channel storage 
(Mac OS 9 or earlier, drive format is not be usable 
with Mac OS X).

Apple® The hard drive’s partition information indicates it 
was used as a boot drive for a Macintosh® system 
(Mac OS 9 or earlier).

ATTO The hard drive’s partition information indicates it 
was connected to a Macintosh system by an ATTO 
adapter board (Mac OS X).
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Drive Type Indicator

Each drive in the storage subsystem has a drive icon. If “FC” appears 
on a drive’s icon, the drive is a Fibre Channel drive. If FC does not 
appear, the drive is a SCSI or IDE drive.

ATTO Stripe The hard drive’s partition information indicates it 
was part of a striped set connected to a Macintosh 
system by an ATTO adapter board (Mac OS X).

MediaNet Stripe The hard drive’s partition information indicates it 
was part of a MediaNet Fibre Channel shared 
storage environment.

FAT 16, FAT 32, FAT 32 
XINT13

The hard drive’s partition information indicates it 
has been formatted for use in a DOS environment 
(Windows).

LDM The hard drive’s partition information indicates it 
is a dynamic drive (Windows 2000).

LDM Stripe The hard drive’s partition information indicates it 
is a striped dynamic drive (Windows 2000).

NTFT The hard drive’s partition information indicates it 
is part of a Windows 2000 fault-tolerant partition. 

NTFS Stripe The hard drive’s partition information indicates it 
is a striped dynamic drive used with 
Windows 2000.

IFS The hard drive’s partition information indicates the 
drive has an older DOS partition.

Table 2-2 Partition Status Indications (Continued)

Status Description
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Volume View

Volume view presents, in an expandable tree structure, a logical view 
of the volumes you have created for your storage subsystem and the 
hard drives that make up those volumes.

Figure 2-6 shows the main window with Volume view active.

Figure 2-6 Volume View Features

Volume 
name

Availability/testing status Partition statusHard drive description

Mount status

Striped set 
disk total

Drive icon

Raw drives 
list
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Volume view has many of the same features as Physical view. Features 
that the two views have in common are:

• Hard drive description

• Availability/testing status

• Partition status

• Drive type indicator

For a description of these features, see “Physical View” on page 2-5. 
The remainder of this chapter describes features that are specific to 
Volume view.

Raw Drives List

Volume view lists all unformatted drives in a Raw list. To view your 
raw drives, expand the Raw list.

Volume Name

Each volume has a specific name. A volume is a logical storage unit 
that might use only one physical drive or span across multiple drives. 
Volumes that span across multiple drives are called striped. Each 
volume name expands to show the drives that make up that volume.
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Mount Status

To the left of the volume name is the mount status. Table 2-3 describes 
the mount status indications you might see.

Striped Set Drive Total

If a volume is made up of a striped set of drives, the number of drives 
in the set is listed to the left of the volume’s mount status indicator.

Table 2-3 Mount Status Indications

Status Description

Mounted The hard drive is currently mounted on your Avid 
system.

Unmounted The hard drive is not currently mounted on your 
Avid system.

Broken The volume is made up of multiple hard drives that 
are part of a striped set, and one or more of the 
drives in the set are unavailable. If shown for a Raw 
drive, the drive is having a problem.
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Toolbars and Menus

Avid Storage Manager has two toolbars, one on the top and one on the 
side, that allow you to access features quickly and easily. All the 
buttons in the top toolbar have menu equivalents that you can access 
by using the menus in the menu bar. 

Top Toolbar and Menu Equivalents

Table 2-4 describes the buttons in the top toolbar and gives their menu 
equivalents.

Table 2-4 Top Toolbar Buttons

Button Button Name Description Menu Equivalent

Physical View Displays Physical view in the main 
window.

View > Physical

Volume View Displays Volume view in the main 
window.

View > Volume

Console Displays the Console window, which 
allows you to view test results and 
firmware updating results.

View > Console

Rescan System 
Configuration

Initiates a rescan of the entire storage 
subsystem and updates Physical view 
and Volume view with the results.

Edit > Rescan Configuration

Set User 
Preferences

Displays the User Preferences dialog box, 
where you can set the default behavior 
for a variety of features.

Edit > User Preferences

Update 
Firmware on 
Drives

Initiates a firmware download to an Avid 
hard drive (Windows only).

Edit > Update Firmware
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Side Toolbar

Table 2-5 describes the buttons in the side toolbar. These buttons do 
not have menu equivalents.

Save System 
Configuration

Saves the current configuration of your 
storage subsystem. This configuration file 
can be used by Avid Customer Support 
for diagnostic purposes.

File > Save Configuration

Send File Displays the Send File dialog box that 
allows you to send a log file by e-mail to a 
recipient you specify.

File > Send File

Exit Application Closes Avid Storage Manager. File > Exit

Help Displays the Avid Storage Manager 
Help contents.

Help > Contents

Table 2-4 Top Toolbar Buttons (Continued)

Button Button Name Description Menu Equivalent

Table 2-5 Side Toolbar Buttons

Button Button Name Description

Identify Identifies the hard drives currently selected in the main 
window by flashing the drives’ disk activity LED.
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Using Avid Storage Manager with Other Utilities

You can use Avid Storage Manager in conjunction with other Avid 
configuration and diagnostic utilities designed to set up and 
troubleshoot your Avid components. These utilities include:

• Avid System Test Pro — This utility tests an Avid editing system to 
make sure that the Avid components and peripheral boards are 
functioning properly.

• AvidStartup — This utility ensures that the Avid storage media 
performance parameters are set correctly for your Avid software.

Spin Down Spins down the shuttles currently selected in the main 
window in preparation for swapping the shuttles. This 
feature parks the heads, stops the disk rotation, and puts the 
drives in idle mode.

For more information on Spin Down, see “Spinning Down 
Hard Drives” on page 3-13.

n This feature is not supported for IDE drives.

Test Displays the Test window that you use to set up and run tests 
on your Avid hard drives.

Close Closes Physical view or Volume view, depending on which 
view is active.

Help Displays a context-sensitive Help window with information 
about the main window’s current view (Physical or Volume).

Table 2-5 Side Toolbar Buttons (Continued)

Button Button Name Description
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CHAPTER 3

Using Avid Storage Manager

This chapter provides information on using Avid Storage Manager’s 
features, with the exception of hard drive testing. For information on 
hard drive testing, see Chapter 4.

This chapter describes the following features:

• Starting and Stopping Avid Storage Manager

• Setting User Preferences

• Selecting Hard Drives

• Viewing Hard Drive Information

• Identifying Hard Drives

• Spinning Down Hard Drives

• Rescanning the Storage Subsystem

• Saving the Storage Subsystem Configuration

• Sending Error Log and Configuration Files

• Updating Hard Drive Firmware (Windows Only)
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Starting and Stopping Avid Storage Manager

To start Avid Storage Manager on a Windows 2000 system:

t Click the Start button, point to Programs, point to Avid, and then 
click Avid Storage Manager.

To start Avid Storage Manager on a Macintosh system:

t Navigate to Avid drive:Applications:Utilities:Avid Storage 
Manager and double-click the AvidStorageManager icon.

To stop Avid Storage Manager:

t Click the Exit button, or choose Exit from the File menu.

Setting User Preferences

You can set user preferences that determine how Avid Storage 
Manager behaves by default. You can set:

• The initial view for the main window (Physical view or Volume 
view)

• The default window location, size, and look and feel

• The default e-mail setup to use when sending log and 
configuration files
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To set user preferences:

1. Click the User Preferences button in the top toolbar, or choose 
User Preferences from the Edit menu. The User Preferences dialog 
box appears.

2. Click the tab for the preferences you want to set. See Table 3-1 
through Table 3-3 for descriptions of the options on each tab.

3. Make your changes, and click Apply.

4. Repeat steps 2 and 3, if necessary, to set the options on the other 
tabs.
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5. When you have finished setting user preferences, click OK to close 
the dialog box.

6. Exit Avid Storage Manager, and then restart it to make your new 
user preferences active.

Table 3-1 Window User Preferences

Option Type Option Description

Default Location Top Left of Display 
(Default)

The Avid Storage Manager window 
opens in the upper left corner of 
your display.

Centered in Display The Avid Storage Manager window 
opens in the center of your display.

Current Position The Avid Storage Manager window 
opens in the same location that it 
was in when it was last exited.

Default Size Optimized for 
Display (Default)

The Avid Storage Manager window 
is displayed as large as possible, up 
to 800 by 600 pixels.

Maximized in 
Display

The Avid Storage Manager window 
is sized to fill the entire display.

Current Size The Avid Storage Manager window 
opens using the same dimensions it 
had when it was last exited.
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Table 3-2 View User Preferences

Option Type Option Description

Default Window Physical View 
Window (default)

When it starts, Avid Storage 
Manager displays Physical view.

Volume View 
Window

When it starts, Avid Storage 
Manager displays Volume view.

Main Window Only When it starts, Avid Storage 
Manager displays the main 
window with neither Physical view 
nor Volume view showing.

Default Look & 
Feel

CDE/Motif Avid Storage Manager uses CDE 
and Motif® style windows.

MacOS Adaptive Avid Storage Manager uses 
Mac OS X style windows.

Metal Avid Storage Manager uses Metal 
style windows.

Windows Avid Storage Manager uses 
Windows style windows.

ASMUser.book  Page 5  Monday, June 10, 2002  10:31 AM



3-6

Using Avid Storage Manager

Selecting Hard Drives

Selecting hard drives in both Physical view and Volume view is 
important. A solid understanding of hard drive selection will keep 
you from selecting the wrong drives inadvertently, which could cause 
a problem if you are running a destructive test.

c Running a destructive test destroys the data on a hard drive. Do not 
run a destructive test on your internal boot drive or on any drive that 
has data you want to keep.

Table 3-3 E-mail User Preferences

Option Description

Recipient E-mail 
Addresses

The default e-mail address for the recipient of log and 
configuration files.

Sender E-mail 
Address

The default e-mail address for the sender of log and 
configuration files.

Outgoing Mail 
(SMTP) Server

The name of the SMTP server used to deliver the 
e-mail. To use this feature, the system running Avid 
Storage Manager must have a network connection to an 
SMTP server.

E-mail Subject The default subject for the log and configuration file 
e-mails.
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Selecting a Single Drive

Selecting a single drive functions identically in Physical view and 
Volume view.

To select a single drive in Physical view or Volume view:

t Click the check box next to the hard drive description to enable it. 
If you select a drive that is part of a striped set, Avid Storage 
Manager will ask you if you want to select all the drives in the set 
or just the one you clicked.

Selecting Multiple Drives

Selecting multiple drives functions slightly differently in Physical 
view and Volume view.

To select multiple hard drives in Physical view:

t Click the check box next to the adapter board description to select 
all drives that are connected via that adapter board.

Selecting a single 
drive in Physical 
view

Selecting a single 
drive in Volume 
view

Selecting multiple 
drives in Physical 
view
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To select multiple hard drives in Volume view:

t Click the check box next to the volume description to select all the 
drives that make up that volume.

n You can also use the Shift and Ctrl keys to select multiple drives.

Viewing Hard Drive Information

Avid Storage Manager provides two features for getting hard drive 
information. One feature provides details on the physical hardware for 
a drive. The other feature provides information on the volumes that 
use all or a portion of the hard drive’s storage space.

Viewing Hardware Information

To view the hardware information for hard drives:

1. In either Physical view or Volume view, select the hard drives on 
which you want information by clicking their check boxes.

2. Right-click (Windows) or Control+click (Macintosh) a selected 
hard drive’s description, and choose Device Information from the 
menu. 

The Device Information dialog box appears. If you have multiple 
hard drives selected, multiple dialog boxes appear, one on top of 
the other. 

See Table 3-4 for detailed descriptions of the information 
contained in the Device Information dialog box.

Selecting multiple 
drives in Volume 
view
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3. Click OK to close a Device Information dialog box.

n To view Device Information dialog boxes that are hidden, click OK to close the 
topmost dialog box.

Table 3-4 Device Information Dialog Box

Label Description or Comment

Device A description of the selected hard drive. 

Windows) This information includes the drive type, its bus 
ID, its device ID, and its LUN ID. For example, HDD 1:1:0 
indicates a hard drive on bus 1 with a device ID of 1 and 
LUN of 0.

(Macintosh) This information includes the drive type, its 
bus ID, its device ID, its LUN ID, and an unused ID. For 
example, HDD 64:0:0:0 indicates a hard drive on bus 64 
with a device ID of 0 and LUN of 0.

n Bus numbers for SCSI drives start at 0. Bus numbers for 
FireWire drives start at 64.
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Format The type of partition that currently exists on the hard 
drive. For complete information, see Table 2-2 on 
page 2-10.

Vendor The manufacturer of the hard drive.

Model The hard drive’s model number.

Serial Number The hard drive’s serial number.

Series Code Each Avid hard drive is assigned a series code that 
indicates the type of drive it is (for example, 7,200 RPM, 
second generation 10,000 RPM, and so forth). 

The series code is used when striping drives. Drives 
should have the same series code (that is, the same type) in 
order to be striped together. If you stripe drives of different 
types together, the performance of the striped set is limited 
by the speed of the slowest drive in the set. Drives with 
dissimilar series codes generally should not be striped 
together.

Capacity The storage capacity of the hard drive. The first number is 
based on the industry standard of 1024 bytes/KB, while 
the second number is the actual physical byte count on the 
drive. The actual physical byte count (the advertised byte 
count) is more than the industry-standard byte count.

Table 3-4 Device Information Dialog Box (Continued)

Label Description or Comment
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Status The hard drive’s status. Possible values are:

• Ready: The drive is available and ready for testing.

• Not Ready: The drive is not ready for testing

• Unavailable: The device is something other than a 
hard drive (for example, a CD-ROM drive).

• Testing: The drive is in the process of being tested.

• Passed: The drive has passed its most recent test.

• Failed: The drive has failed its most recent test.

n A drive’s label changes from Passed to Ready only after 
the storage subsystem has been rescanned, either by using 
the Rescan option or by restarting Avid Storage Manager.

Manufacturing 
Date

The date the hard drive was manufactured, in Julian 
notation. For example, 01/360 indicates the drive was 
manufactured on the 360th day of the year 2001.

n The manufacturing date is not available for all drives.

Firmware 
Revision

The hard drive’s firmware revision.

Servo Revision The hard drive’s servo code revision. Servo code is 
responsible for keeping the drive heads on track.

n The servo revision is not available for all drives.

Table 3-4 Device Information Dialog Box (Continued)

Label Description or Comment
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Viewing Volume Information

To view volume information for hard drives:

1. In either Physical view or Volume view, select the hard drives on 
which you want information by clicking their check boxes.

2. Right-click (Windows) or Control+click (Macintosh) a selected 
hard drive’s description, and choose Device Volumes from the 
menu. The Device Volumes dialog box appears. If you have 
multiple hard drives selected, multiple dialog boxes appear, one 
on top of the other.

The Device Volumes dialog box contains the following 
information:

• The hard drive’s description includes the drive type, its bus 
ID, its device ID, and its LUN ID (for example, HDD 1:10:0).

• The name of any volumes that use all or a portion of the hard 
drive’s storage capacity.

In addition to the volume name, the dialog box provides the 
volume’s mount status (Mounted, Unmounted, or Broken), its 
stripe status (Striped or Unstriped), and its size.

3. Click OK to close the Device Volumes dialog box.
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Identifying Hard Drives

The Identify button in the side toolbar provides a visual aid that 
allows you to match up the hard drive descriptions in the main 
window with the physical hard drives in your storage subsystem.

To identify hard drives:

1. In either Physical view or Volume view, select the hard drives you 
want to identify by clicking their check boxes.

2. Click the Identify button in the side toolbar. The Identify Device 
dialog box appears, indicating that the drive activity LEDs for the 
drives you selected are blinking.

3. Click OK to close the Identify Device dialog box and stop the 
blinking LEDs.

Spinning Down Hard Drives

You can use Avid Storage Manager to spin down your Avid shuttles. 
The spin down operation parks the drive heads, stops the drive from 
rotating, and ensures that the drive can be safely swapped without 
loss of data or damage to the drive.

You should use the Identify feature to identify drives before spinning 
them down (see “Identifying Hard Drives” on page 3-13). Only 
removable drives that you plan to remove should be spun down. If a 
fixed drive or an internal system drive is spun down, it must be turned 
off and then turned on for it to spin up again.

n You cannot use this feature to spin down IDE drives because IDE drives do 
not support a spin down command.
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To spin down hard drives:

1. Make sure the hard drive you want to spin down does not have 
any volumes that are mounted. If it does, unmount the volumes 
before spinning down the drive.

2. In Physical view or Volume view, select the hard drives you want 
to spin down by clicking their check boxes.

3. Click the Spin Down button in the side toolbar.

4. Avid Storage Manager waits 30 seconds to ensure that the drives 
are all spun down. When the hourglass cursor goes away, the spin 
down is complete.

n For information about spinning up a shuttle, see your shuttle enclosure 
documentation. In most cases, the shuttle spins up when it is inserted into the 
shuttle enclosure. If you inadvertently spin down a fixed drive, you must 
turn the drive power switch off and then on to spin the drive back up for use.

Rescanning the Storage Subsystem

You can manually initiate the scan-for-storage operation by using the 
Rescan button in the top toolbar or choosing Rescan Configuration 
from the Edit menu. When the Rescan option is activated, Avid 
Storage Manager scans all the hard drives in your storage subsystem 
and updates the information in the main window.

n Hard drives with an availability/testing status of Passed, Failed, or Updated 
change their status back to Ready when the storage subsystem is rescanned. 
Rescanning might not find hard drives or shuttles that were added to the Avid 
system since the last system boot. 
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(Windows) If you have added hard drives since the last system boot, run Disk 
Manager to rescan the buses and then click the Rescan button to locate the 
new hard drives. If the new hard drives still do not appear, reboot the system.

(Macintosh) If you have added hard drives since the last system boot, restart 
the Macintosh and run Avid Storage Manage to locate the new hard drives.

Saving the Storage Subsystem Configuration

In Avid Storage Manager, you can save your storage subsystem’s 
configuration to a log file. Avid Customer Support can use the 
information in this file for diagnostic purposes.

To save the storage subsystem configuration:

1. Click the Save Configuration button in the top toolbar, or choose 
Save Configuration from the File menu. The Save Configuration 
dialog box appears.

2. Click Browse, and navigate to the location where you want to save 
the configuration file.

3. Type a name for the file. The default is

ASMConfig-MM.DD.YY.txt

where MM is the month, DD is the day, and YY is the year the file 
is created.

4. Click OK, and then click OK again to close the Save Configuration 
dialog box and save the file.
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Sending Error Log and Configuration Files

You can send error logs and configuration files directly from Avid 
Storage Manager to other locations through e-mail. You can use this 
feature to send error and configuration information to Avid Customer 
Support to diagnose storage-related problems.

c Before using the e-mail feature, make sure the computer running 
Avid Storage Manager has a network connection to an SMTP server.

n Error logs are generated while testing your hard drives. For more 
information, see Chapter 4.

To send a log file:

1. Click the e-mail button in the top toolbar, or choose Send File from 
the File menu. The e-mail Log File dialog box appears.

The dialog box is partially filled in with information from the 
e-mail preferences you set (see “Setting User Preferences” on 
page 3-2).

You can accept this information, or you can override it by entering 
new information in the text boxes.

2. Click Browse to locate the error log or configuration file you want 
to send. The Select File dialog box appears.

3. Select the file you want to send, and click OK to return to the 
E-mail Log File dialog box.

4. Click OK to send the file.

n You can enter the file name manually. If the file does not exist in the directory 
where Avid Storage Manager is installed (C:\Program Files\Avid\
Utilities\Avid Storage Manager, by default), you will have to enter the entire 
path.
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Updating Hard Drive Firmware (Windows Only)

c Do not perform this procedure unless directed to do so by Avid 
Customer Support.

You can use Avid Storage Manager to update the firmware on your 
Avid hard drives. When you use this feature, all hard drives that are 
acceptable candidates for the updated firmware package are updated 
automatically. You cannot pick specific hard drives for updating. A 
drive is an acceptable candidate for updating if it is the correct type of 
drive for the updated firmware and its current firmware is older than 
the updated firmware.

Obtaining an Updated Firmware Package

Updated firmware packages are distributed through:

• The Avid Knowledge Center

• The Avid Storage Utilities CD-ROM

c Always exit Avid Storage Manager before retrieving firmware 
updates.

To retrieve an updated firmware package from the Avid Knowledge 
Center:

1. Open an Internet browser, and go to www.avid.com.

2. Click Support.

3. Click Knowledge Center. A new browser window opens with the 
Knowledge Center displayed.

4. Click the Downloads tab, and locate the firmware update (you can 
use the Search feature to find the update).
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5. Download the firmware update to the following location: 

C:\Program Files\Avid\Utilities\Avid Storage Manager\
FirmwarePackages

6. Uncompress the update file.

n If you installed Avid Storage Manager to a directory other than the default, 
copy the firmware update to the FirmwarePackages directory in that location 
instead.

To retrieve an updated firmware package from the Avid Storage 
Utilities CD-ROM:

1. Insert the Avid Storage Utilities CD-ROM into the CD-ROM drive.

2. Open Windows Explorer, and navigate to the Avid Storage 
Manager directory on the Avid Storage Utilities CD-ROM.

3. Copy the firmware update package from the Avid Storage 
Manager directory to the following location: 

C:\Program Files\Avid\Utilities\Avid Storage Manager\
FirmwarePackages

n If you installed Avid Storage Manager to a directory other than the default, 
copy the firmware update to the FirmwarePackages directory in that location 
instead.
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Updating the Hard Drives

After downloading the firmware update package, you are ready to 
update your Avid hard drives.

To update the firmware for your Avid hard drives:

1. Start Avid Storage Manager.

2. Click the Update Firmware button, or choose Update Firmware 
from the Edit menu.

Avid Storage Manager checks for drives that require updating, 
prints the list in the Console window, and checks for available 
firmware update files. A dialog box appears, telling you the 
number of drives to be updated and asking if you want to 
continue.

3. Click Yes to continue. Avid Storage Manager updates any Avid 
hard drives that are the correct type for the firmware update and 
that currently have an older version of firmware.

c Do not stop Avid Storage Manager or turn off hard drives when 
performing a firmware update. Doing so might cause the drives to 
become inoperable, requiring them to be returned to Avid for 
replacement at Avid Customer Support’s discretion.
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CHAPTER 4

Testing Hard Drives

This chapter provides detailed information on the tests you can 
perform with Avid Storage Manager on your Avid hard drives. It 
includes:

• Nondestructive and Destructive Tests

• Testing Your Hard Drives

• Test Templates

• Test Parameters

• Interpreting Error Messages
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Nondestructive and Destructive Tests

There are two types of tests you can perform with Avid Storage 
Manager: nondestructive and destructive. Nondestructive tests only 
read the data that is on the hard drive. They do not write any data to 
the hard drive.

Destructive tests write data to the drive and then read that data. The 
data is then compared to the original data to verify that the write and 
read functions of the hard drive are working correctly. These tests 
destroy any data and file system structure that are on the drive.

c Running a destructive test destroys all the data currently on a hard 
drive. Do not run a destructive test on your internal boot drive or on 
any drive that has data you want to keep.

n Destructive tests are not sufficient for a security erase.

Testing Your Hard Drives

To perform a test, you must:

1. Set up the test either by using one of Avid’s test templates or by 
specifying test parameters yourself.

2. Run the test.

3. Review the test results.

The following sections provide instructions for performing these tasks. 
For more detailed descriptions of the test templates and the test 
parameters, see “Test Templates” on page 4-8 and “Test Parameters” 
on page 4-9.
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Using a Test Template

Avid has created three test templates to aid you in testing your hard 
drives. Each template has its own set of test parameters that are set for 
you automatically. For detailed descriptions on the templates 
themselves, see “Test Templates” on page 4-8.

To use a test template:

1. Select one or more drives to test.

2. Click the Test button. The Test window opens.

ASMUser.book  Page 3  Monday, June 10, 2002  10:31 AM



4-4

Testing Hard Drives

3. Choose a test template from the Template menu. The test 
parameters in the remainder of the Test window are set according 
to the template you chose.

4. To run the test now, using the parameters that are set, follow the 
instructions in “Running a Test” on page 4-4.

Creating a Custom Test

You can create a custom test by taking an existing template and 
modifying it to your needs.

To create a custom test:

1. Select one or more drives to test.

2. Click the Test button. The Test window opens.

3. Choose the template you want to modify from the Template menu.

4. Change any test parameters in the remainder of the Test window. 
The Template menu automatically changes to User Selected to 
indicate that you have customized the template.

5. To run the test now that the parameters are set, follow the 
instructions in “Running a Test” on page 4-4.

Running a Test

Once you have set the test parameters, either by a template or by 
creating a custom test, you are ready to run the test.

c Running a destructive test destroys the data on a hard drive. Do not 
run a destructive test on your internal boot drive or on any drive that 
has data you want to keep. Use the Identify feature to verify that you 
are testing the correct drive (see “Identifying Hard Drives” on 
page 3-13).
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To run a test:

1. After setting the test parameters, click Start in the Test window. If 
you have chosen a destructive test, Avid Storage Manager asks 
you to confirm that you want to continue with the test.

The test begins running, and the Status indicator at the bottom of 
the Test window begins tracking the test. This indicator tracks each 
pass of the test, not the entire test as a whole.

2. Use the following options to control the test while it is running:

- To pause the test, click Pause (the button label switches to 
Resume). Click Resume to restart the test from where it left off.

Avid Storage Manager retains the present state of the test and 
all test parameters during a pause. 

- To stop the test altogether, click Stop. The test parameters are 
saved for a future restart, but all other testing information 
(elapsed time, error counts, and so forth) are reset.

- To view test results as the test is being run, click Console. The 
Console window opens. For more information on the Console 
window, see “Viewing Test Information” on page 4-5.

Viewing Test Information

You can view test information in two ways: by using the Console 
window or by looking at the error log file, if you opted to create one 
during the test. To view test status while the test is running, use the 
Console window. To view test status after the test is completed, look at 
the error log file. Test status information includes:

• A list of all the drives connected to the Avid system, including the 
drive type, bus ID, device ID, and LUN ID

• The type of test being run

• The set of test parameters used to perform the test

• A list of the drives being tested
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• The status of each drive that is being tested

• Error messages

• The total number of blocks transferred for each drive (read and 
write blocks)

You can also view a summary of the test while it is running, paused, or 
after it has finished. A test summary has a line for each drive under 
test and each pass of the test. Test summaries include:

• A drive’s bus ID, device ID, and LUN ID

• The test pass number

• The number of read commands

• The number of sectors read

• The number of write commands

• The number of sectors written

• The number of errors

• The number of reallocated blocks

• The maximum, minimum, and average time for the read and write 
commands, in milliseconds

• The total number of I/Os per second for the entire storage 
subsystem

n A test’s status information is always followed by a summary at the end of the 
test, in both the Console window and the log file.

To view a test’s results using the Console window:

1. Open the Console window using one of the following methods:

t In the Test window, click Console.

t Click the Console button in the top toolbar.

t Choose Console from the View menu.
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2. The Console window opens, displaying test information.

3. To view a summary of the test, click Summary.

4. When you are finished looking at the information in the Console 
window, click Close.

To view test information in a log file:

t (Windows) The log file is an ASCII text file. Open it in Notepad or, 
if it is too large for Notepad, in WordPad.

t (Macintosh) The log file is an ASCII text file. Open it in TextEdit or, 
if it is too large for TextEdit, in word processing application.

n You can also choose to send your log files to a recipient that you specify. For 
more information, see “Sending Error Log and Configuration Files” on 
page 3-16.
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Test Templates

Table 4-1 describes Avid Storage Manager’s test templates. Each 
template uses a specific set of test parameters that are described in 
“Test Parameters” on page 4-9.

Table 4-1 Test Templates

Test Description Test Parameters

Extended Test 
(nondestructive)

This test provides an overall check of 
the storage subsystem. It 
nondestructively reads random 
blocks on the disk. Each pass reads 
the entire surface and then runs a 
random read test for approximately 
60 minutes. You set the number of 
passes and the test length for the 
random read test, in minutes.

Test Type: Sequential Read/Random Read

Log File: Keep Log

Name: ASMLog-MM.DD.YY.txt

Error Halt: None

Test Data Pattern: Random

Test Length: Full Surface + 60 Minutes

Number of Passes: 1

n All other options are disabled.

Quick Check 
(nondestructive)

This test provides a quick indication 
of any serious problems in the Avid 
storage subsystem. It 
nondestructively reads random 
blocks on each drive, and it runs for 
30 minutes.

Test Type: Random Read

Log File: Keep Log

Name: ASMLog-MM.DD.YY.txt

Error Halt: None

Test Length: 30 Minutes

Number of Passes: 1

n All other options are disabled.
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Test Parameters

Table 4-2 describes the test parameters you see in the lower portion of 
the Test window. The first parameter, Test, is broken out into 
nondestructive and destructive tests.

Surface Scan 
(nondestructive)

This test reads the entire surface area 
of a selected Avid drive. You run it 
primarily to detect media errors on 
selected drives.

When you use this test, you are 
prompted to choose whether or not 
to automatically reallocate any blocks 
that have media errors. Reallocating 
bad blocks scrubs the disk surface 
clean of media defects.

If you choose to reallocate bad 
blocks, Avid Storage Manager 
reallocates a bad block’s address to a 
good block and, if possible, copies 
the data from the bad block to the 
good block. If the data in the original 
block is unreadable, it is still 
considered damaged so Avid Storage 
Manager marks it as bad. Writing 
data into the reallocated block erases 
Avid Storage Manager’s bad mark 
and writes good data into the 
reallocated block.

Test Type: Surface Scan

Log File: Keep Log

Name: ASMLog-MM.DD.YY.txt

Error Halt: None

Number of Passes: 1

n All other options are disabled.

User Selected This option is automatically selected 
when you modify a test template.

User Selected, by its definition, indicates that 
you have set your own custom parameters.

Table 4-1 Test Templates (Continued)

Test Description Test Parameters
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Table 4-2 Test Parameters

Parameter Possible Values

Test
(nondestructive)

Random Read (default): This test picks a random starting point on the drive 
and a random number of sectors to test. It then reads the drive’s data, starting 
with the random starting point and ending after the random number of sectors 
has been read.

Convergence/Divergence Read: This test picks a random number of sectors to 
test. It then reads that number of sectors at the beginning of the drive. After the 
beginning of the drive is read, the test goes to the end of the drive and reads 
the same random number of sectors. The test then returns to where it left off at 
the beginning of the drive, picks a new random number of sectors, and repeats 
the same process. The test continues until the entire disk has been read twice. 
The Convergence/Divergence test is useful for identifying problems with the 
drive heads or with the drive’s servo system.

Sequential Read: This test reads the data on the drive from beginning sector to 
the last sector.

Sequential Read/Random Read: This test starts by reading the data on the 
drive from the beginning sector to the last sector. It then picks a random 
starting point on the drive and a random number of drive sectors to test. The 
test reads the data starting at the random starting point and ending after the 
random number of sectors are read. This random read is repeated for the 
specified test length.

End of 
Drive

Beginning 
of Drive

This read starts from the 
beginning of the drive.

This read starts from 
the end of the drive.
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Test
(destructive)

Random Write/Read: This test picks a random starting point on the drive and a 
random number of drive sectors to test. It then writes data to the drive, reads 
the data back, and compares it to the original data. Writes and reads are done 
in pairs; that is, the test writes to a group of sectors, reads the data back, writes 
to another group of sectors, and reads the data back, and so on until the test is 
complete.

Sequential Write/Read: This test writes data from the beginning of the drive to 
the end of the drive, reads that data back from beginning to end, and compares 
it to the original data.

Sequential Write/Random Read: This test writes data from the beginning of 
the drive to the end of the drive. It then picks a random starting point on the 
drive and a random number of drive sectors to test. The test reads the data 
starting at the random starting point and ending after the random number of 
sectors are read. This random read is repeated for the specified test length.

Surface Scan: This test scans the entire surface area of the drive. It is run 
primarily to detect medium errors. When you select this test, you are prompted 
to choose whether or not to automatically reallocate any blocks that have 
medium errors, effectively scrubbing the disk surface clean of media defects. If 
you choose to reallocate blocks, this test will become destructive if any 
medium errors are found and reallocated. If not, the test is nondestructive.

Format Test: This test performs a low-level format on the drive. You should use 
this test only when directed to do so by Avid Customer Support. If you stop 
this test before it is complete, the drive might be rendered inoperable, requiring 
the drive to be returned to Avid for replacement. This test cannot be used with 
IDE or FireWire drives.

Random Write: This test picks a random starting point on the drive and a 
random number of drive sectors. It then writes data between those two points. 
This test is useful for diagnostics.

Sequential Write: This test writes data from the beginning of the drive to the 
end of the drive. This test is useful for diagnostics.

Table 4-2 Test Parameters (Continued)

Parameter Possible Values
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Log File Keep Log: Select this option to keep a log file for the tests you are running. 
Error logs are cumulative on a daily basis. An error log is appended with 
information from each test you run during a single day (as indicated by the 
computer’s internal date at the start of the test). When the date changes, a new 
error log is started. However, if a test runs over the course of several days, only 
one log file is generated for the entire test.

No Log: No error log is generated while your tests are run.

n For more information on the naming conventions for error log files, see the 
Name parameter.

Name When the Keep Log option is selected, the Name box is enabled. This box 
contains the name of the log file to be generated during testing. By default, this 
name uses the following format:

ASMErrorLog-MM-DD-YY.txt

You can overwrite the default file name with your own name by typing it in the 
Name box. You must enter the entire path if you are saving to a directory other 
than C:\Program Files\Avid\Utilities\Avid Storage Manager. You can also 
use the Browse button to relocate or name the log file.

Table 4-2 Test Parameters (Continued)

Parameter Possible Values
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Error Halt None (default): The test continues even when an error is encountered. The 
exception to this rule occurs when a catastrophic error is encountered. 
Catastrophic errors stop the test because they are not likely to go away and 
they fill up the error log with redundant error information.

Any Error: The test is stopped when any drive encounters an error, regardless 
of the error type.

Media Error: The test is stopped when any drive encounters a nonrecoverable 
media error. A media error is an error in the magnetic disk medium, for 
example, a bad sector on the disk.

Nonrecoverable Error: The test is stopped when any drive encounters a 
nonrecoverable error. Nonrecoverable errors include the following:

• A unit attention result that is not the result of a disk power on or a SCSI 
reset command

• An illegal request error

• An aborted command error

• Most driver errors

Catastrophic Error: The test is stopped when a catastrophic error is 
encountered. Catastrophic errors include the following:

• A drive appears to have gone away

• A drive not ready error

• A hardware error

• A data protection error

• Any error that is not otherwise recognized

User Defined: The test is stopped when an error count that you specify is 
reached. The error count applies to any error type.

Errors If you choose User Defined for the Error Halt parameter, type the number of 
errors required before the test stops into the Errors text box. The number you 
type must be greater than 5. It is the maximum number of errors for each drive 
in the test.

Table 4-2 Test Parameters (Continued)

Parameter Possible Values
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Data Compare Mode Compare All Data (default): For write/read tests, the data that is written to a 
hard drive and then read back is compared to the original data for 
discrepancies.

No Data Compare: No data comparison is made between the data that is 
written to a hard drive during a write/read test and the original data.

Compare First Sector: For write/read tests, the first 512 bytes of data written to 
a hard drive and then read back is compared to the original data for 
discrepancies.

Test Data Pattern Random (default): Random data is written to the drive.

Alternating: The data written to the drive uses alternating words made up of 
all 0s (zeros) or all 1s (ones).

Incrementing Byte: The data is written using an incrementing byte pattern 
where the 00 byte is never used. Skipping the 00 byte ensures that, as the data 
repeats itself, it never falls on sector boundaries. This prevents the repetition of 
the pattern from masking possible data corruption problems.

Incrementing Word: The data is written using an incrementing word pattern.

User Defined: This option allows you to specify a number greater than 5 that 
will be used as the repeating pattern.

Pattern If you choose User Defined for your Test Data Pattern parameter, type a 
number greater than 5 in the Pattern text box.

Test Length 30 Minutes (default): The test runs for 30 minutes and then stops.

60 Minutes: The test runs for 60 minutes and then stops.

120 Minutes: The test runs for 120 minutes and then stops.

User Defined: The test runs for the amount of time you specify in the Minutes 
text box. It is applicable only to random tests.

Minutes If you choose User Defined for your Test Length parameter, type the number of 
minutes that the test runs before it stops in the Minutes text box.

Table 4-2 Test Parameters (Continued)

Parameter Possible Values
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Interpreting Error Messages

The error messages that you see in the Console window or in your 
error log files give you valuable information about the state of your 
hard drives. For descriptions of the most common errors, see 
Appendix A.

Number of Passes 1 (default): The test runs once and then stops.

Infinite: The test runs until you stop it manually by clicking Stop in the Test 
window.

User Defined: The test runs for the specified number of passes indicated in the 
Passes text box. A pass is complete for a sequential test either when the whole 
disk has been accessed or when the time period for the test runs out.

Passes If you choose User Defined for your Number of Passes parameter, type the 
number of passes required, in the Passes text box, before the test stops.

Table 4-2 Test Parameters (Continued)

Parameter Possible Values
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APPENDIX A

Interpreting Error Messages

This appendix provides information on the most common error 
messages you might see in the Console window and the steps you can 
take to fix the errors.
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Error Messages

Table A-1 describes the most common error messages that might be 
generated while testing Avid hard drives and includes possible 
corrective actions for each error message to aid in diagnosing and 
fixing problems.

n Error messages are referred to as “sense keys” in the Avid Storage Manager 
Console window.

Table A-1 Error Messages

Error Message Description Comment or Action

00 NO SENSE The operation completed 
successfully with no errors.

None required.

01 RECOVERED ERROR The operation completed 
successfully with some recovery 
action performed by the drive.

Recovered errors are usually not a major 
concern. Run the Surface Scan test, and 
then rerun the test that had the errors.

02 NOT READY Indicates that the drive cannot 
be accessed. User intervention 
might be required to correct this 
condition. 

Wait 2 minutes, and retry the test. If the 
error reoccurs, turn the drive’s power off 
and then on, wait 2 minutes, and retry the 
command. If the error persists, replace the 
drive.

03 MEDIUM ERROR An 03 - 11 error indicates that 
the command terminated with 
an unrecoverable error 
condition probably caused by a 
flaw in the medium or an error 
in the recorded data. 

Run the Surface Scan test, enabling block 
reassignments, and then rerun the test that 
failed.

An 03 - 31 error indicates a 
format corruption problem. This 
might occur after a firmware 
download. It might also occur if 
a low-level drive format was 
started and not completed. 

Run the Format test, and do not interrupt 
or turn off the hard drive or the Avid 
system until the reformatting is complete.
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04 HARDWARE ERROR Indicates that the hard drive 
detected an unrecoverable 
hardware failure while 
performing the test or during a 
self-test.

Turn the drive’s power off and then on, 
and rerun the test. If the error reoccurs, 
replace the drive.

05 ILLEGAL REQUEST Indicates that there was an 
illegal parameter in the test 
command.

This is a software error, not a hardware 
error, and it should not be seen unless the 
software contains a bug.

06 UNIT ATTENTION Indicates that the removable 
medium might have been 
changed or the hard drive has 
been reset or power cycled. 

This is a normal occurrence after power 
cycling the drive or after rebooting your 
Avid system.

This error might be reported at the 
beginning of a test. If the error is reported 
after the initial start of a test, check the 
drive’s cabling, termination, and adapter 
board. 

If the error continues, turn off the first 
drive and rerun the test. If the error 
continues to be reported, turn on the first 
drive and turn off another drive, and rerun 
the test. Continue to cycle through the 
drives until the error is no longer reported. 
The drive that is turned off at this point 
needs to be replaced.

Table A-1 Error Messages

Error Message Description Comment or Action
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0B ABORTED 
COMMAND

The hard drive aborted the test. This usually indicates a bus problem 
caused by a cable, terminator, or adapter 
board seating problem.

Tighten all cable and terminator 
connectors. Reseat the adapter board and 
retest. If the error persists and the drives 
are connected with daisy-chained cables 
(device to device), proceed as follows:

1. Reconfigure the cables to test half the 
drives, move the terminator to the last 
drive still connected in the chain, and            
retry the test. 

2. If the error is no longer reported, add 
one drive at a time to the daisy chain 
and retry the test. 

3. If the error reoccurs, replace the last 
cable that you added and rerun the 
test. 

4. If the error is still reported, remove the 
last drive you added and continue 
with the next drive until all the drives 
have been successfully added to the 
bus and the errors are no longer 
reported. 

5. Replace either the cable or drive that 
failed. 

n If you reconfigure the cables to use half 
the drives, and the error still occurs, 
reconfigure the cables to use the other 
half of the drives and perform steps 1 
through 5 again.
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